Digital Media

We spend a lot of time putting ‘things’ like sounds, pictures, animations and videos - onto the computer so that we can use them - we term these media. To go onto the computer these must all be in a digital form, that is, digitised, and so we have digital media.

In this topic we will concentrate on one main type of digital media - Graphics.

Graphics

Graphics has become a large and important part of computing - particularly for the Macintosh, as this is the computer for many professional Desktop publishers and Graphic Designers.

To allow this process to work effectively, the following diagram illustrates the main points -

![Diagram]

The major features of graphics systems are the need for large amounts of storage, fast processing power and a range of specialised peripheral devices.

Computer graphics, from video games to TV and movie effects have influenced education, art, science, sport and of course business.

To achieve these amazing effects, both software (some kind of graphic program) and hardware (computer, printer, etc.) are required.
Hardware for Graphics

There are two main types of hardware types -

1. Input Devices - including -
   - keyboard
   - mouse
   - joystick
   - graphics tablet
   - light pen
   - scanner *
   - voice actuator *
   - digitising camera

Scanner - an image from a drawing or photograph, can be scanned and the image digitised (turned into a pattern of 0’s and 1’s) so that the computer can represent the image on screen as well as store it on a disk. The main type is the flat bed variety (found in the computer rooms) are now much less expensive scans up to a whole page and gives better quality images.

To achieve input, the scanner’s light shines onto the picture to be scanned and then collects the light reflected back from that image to diodes which produce a varying electrical current and through software to a digital representation of it stored in the computer.

This works for graphics and (with special software - termed optical character recognition or OCR) for text which can be used in a word processor.

Voice Input - this is also known as speech recognition and when done correctly, is about twice as fast as keyboard input by a skilled typist. Input is achieved through a microphone (usually worn as a headset by the operator) which converts the spoken word into a digital code understood by the computer.

The problem with this is that it is very hard for the computer to understand spoken words, and all of the variations people make with pronunciation, ambiguities, inflections, accents, etc. Therefore most speech recognition programs have progressed slowly, with each user having to teach the computer how they say words - thus the computer only has a limited vocabulary. Some recent innovations (combined with video between users) has been a big improvement, but this still is not all that fast, and requires a good deal of memory and setting up.
2. Output Devices - including -

- monitor
- printer
- video
- plotter
- Braille printer

Plotter
A plotter performs a similar job to a printer, but instead of firing ink onto the page a line at a time, it uses pens to draw the images continuously across and down the page. Different pens may be used in turn to create colour drawings - such as in house plans, etc.

You have either used or looked at a number of these devices (input and output) and will use several during the topic.

Assignment - research and answer the following -

1. What is better for graphic designing, a graphics tablet or a mouse? Why?
2. What is a track ball? Why was it invented?
3. In what ways does including graphics in a computer game make the game better, than say a text game?
4. What are animated graphics? How are they different to normal pictures and describe how they are actually produced?
5. Choose 1 input and 1 output device (not one of those with notes) and print out notes on them (like those on scanners and voice input).

Due to be printed out and handed in by - ..............................................................
Exercise 1

To Do - use AppleWorks Draw module to construct the following house, exactly as it appears here -

![House diagram]

SAVE it as HOUSE

Uses of Graphics

1. On paper - the main functions of graphics are to -
   - be informative
   - draw attention to parts of text
   - help page layout and design
   - aid the reader as illustrations or diagrams

2. For television and the movies, graphics and particularly animated graphics are produced on a large scale. All of the television stations have animated logos -
   - (i) Channel 9 - the nine spheres which move into the square pattern
   - (ii) Channel 2 - Quantum has a lizard crawl out of the logo in sand

3. In the movies, special effects have appeared in many instances, such as -
   - Who Framed Roger Rabbit (through the whole movie)
   - Jurassic Park (all sequences with dinosaurs)
   - Terminator II (all morphing sequences)
   - The Abyss (a woman’s face is computer-generated as reflective water)
   - Death Becomes Her (where a woman’s head and body get special effects)
4. CAD (computer assisted drawing) has been producing buildings, cars, yachts, etc. for years which can be rotated, viewed from any orientation, altered, printed out, etc.

5. Scientific - computer graphic enhancements have been used from improving the pictures sent back to earth from space probes, to allowing surgeons to plan and even practice operations on tumours in patient’s heads.

Many other uses have been made of computer graphics, and many more will be made in the future. In order to accommodate such widespread and varied uses, computers need -

- **large memory requirements** - both for the production and storage, and this makes the large computers user for making animated movie sequences very expensive.

- **high processing speed** for animated graphics - thus again large computers (called mainframes) are needed for even a few minutes of movie.

- for personal computers - large colour monitors are essential, plenty of storage area needed and as much RAM as possible (or the usable screen becomes very small).

---

**Exercise 2**

Use the programs Colouring Book and Colour Time to produce some graphic images for **up to 2 periods**, then answer the following questions.

**Questions -**

1. For what age group would you suggest these programs are aimed? Why?
2. What sort of skills do you think they might develop?
3. Did you enjoy using both of these programs? Why?
4. Which of these 2 programs did you like best? Why?
5. What improvements would you suggest for the people who programmed them to make for the future? Why?

To be handed in by - ..................................................
Assignment - Storage devices
Select ONE of the storage devices listed - Video disk, Compact disk, Optical disk, DVD, and describe -

(i) how it actually stores information
(ii) its capacity and its main strengths for graphics

To be handed in by - ................................................

Exercise 3
1. Bring in from home - either a photograph (preferably a clear one in black and white) or a line picture (similar to that on the top of page 4).
2. Use the flatbed scanner, digitise your chosen graphic
3. Type in a story in AppleWorks to go with your graphic and paste the graphic near the middle of the passage (using Text Wrap from the Options menu to move the text around the graphic)
4. Save the page with the name EX3 ______ (with your first name where the line is)

Print the page out to be handed in by - ................................................

How Graphics Are Made
Each graphic image is composed of many tiny dots on the screen called pixels, and these are the monitor equivalent of the dots which the printers put on the page when you print out a picture.

The letter B formed by the pixels on the monitor

one pixel
Exercise 4 - Seeing Pixels

To do -
1. Open AppleWorks Paint
2. Find the Robot graphic (on the right) in the ForStudents folder
3. Copy (in Edit menu)
4. Select Paste (from the Edit menu) and place it in the centre
5. Enlarge the graphic from 100 (bottom left corner) to 200, then 400 and finally 800 or 1600 - what you now see are the individual pixels.
6. Change some of them and see the difference when you go back to 100.

To be completed for marking by - ...........................................................

Types of Graphics

The graphics we create and use on the Macintosh are of 2 basic types -

1. BIT-MAP
2. VECTOR

BIT-MAP

These are paint type graphics, made up of many pixels either turned on or off and displaying a certain colour (or tone). This type of graphic is detailed and realistic, and they are easily shaded with colours or tones - being able to be edited pixel by pixel (as you did in the above exercise).

They do require a lot of computer memory (RAM) to work with on the screen, and a fair bit of storage space on a disk (where a page of words takes about 3K of disk space, a small black and white graphic may take 50 - 100K). If we enlarge bit-map graphics they become blocky, as the pixels become recognisable.

VECTOR

These are drawing type graphics, made up of lines rather than pixels. They therefore take up much less memory and disk space, though producing very clear outlines of shapes, which enlarge without loss of clarity. They are difficult to alter outlines of shapes, since they are lines not areas of dots) but each line can easily be altered.
Exercise 5

1. Use AppleWorks Drawing to draw a plan map of Westfields, based on the Site Plan in your diary - but adding the ovals, car parking areas and any other details which need to be added. Don’t worry about room numbers, but label all other features.

Save this as **School Map**

2. Use AppleWorks Painting to produce a colourful scene based on a tropical island. Add details, shading, etc. as appropriate.

Save this as **Island**

To be completed for marking by - ..........................................................

Questions -
1. What are the differences between the tools in Drawing and Painting?

2. What can you do in Drawing that you cannot in Painting?

3. What can you do in Painting that you cannot in Drawing?

4. Explain why Paint files are larger than Drawing files.

5. Look up the terms - (i) Warping
   (ii) Morphing
   - find out what these are and the difference between them.

Answers to be written or printed out for marking by - ..........................................................
Altering Graphics

A graphic may be altered in a number of ways, including -

- resizing
- cropping
- distorting

Resizing -
This is achieved by either -
(i) selecting the graphic, then choosing Scale Selection (from Options menu) and increasing or decreasing by a chosen percentage.
This is the most accurate way of resizing.

(ii) selecting the graphic, then moving one of the corner boxes in or out to alter the size. This method easily leads to changing the proportions of the graphic if you do not move the corner box exactly diagonally.

Cropping -
This involves selecting part of a graphic and cutting it out to use (maybe with resizing). This is done in Painting, by either rubbing out the unwanted parts, or by selecting with the box or lasso tools.

Distorting -
This is done in Painting, and involving changing the relative proportions of the image. Under the Transform menu - Shear, Distort or Perspective can be use to alter the appearance of a graphic.
Exercise 6

1. Load your graphic HOUSE and resize it to 120%
2. Copy and paste another house (resized to 50%) beside and behind the first one (like it is in the distance)
3. Distort the smaller house
4. Crop the larger house (e.g. get rid of smoke and path)
5. Add some different features to the larger house and its surroundings

Save it (using Save As) with the name HOUSE 2

Questions -

1. Does the quality of the drawn image change as you resize it? If so how, if not why?
2. Can you fill the house in with colours or tones? All / any of the shapes?
3. How could you make the scene more realistic?

To be completed for marking by - .................................................

Colour and Tones

Adding tones or colours (or both) to graphics can make them appear more realistic and also the just look really good on screen. Since we do not have colour printing facilities at school, there is no point trying to print out graphics which are in colour.

The Macs can be set up to display 256 colours and/or tones (shades of grey from white to black) or to thousands of colours and/or tones (requiring more memory but better quality).

The box below is filled to show this range of tones -

These tones (and colours) can be used to fill objects in a variety of patterns - see the 3 boxes below the paint tin 2/3 of the way down the tools section. Use these wisely in the following exercises, as too many colours use up the memory of AppleWorks and reduce the overall size of the Painting page.
Exercise 7

1. Use the various graphics in the file Dinosaurs to copy and paste to make up a realistic Painting scene containing -
   - 6 - 10 dinosaurs,
   - some trees and
   - of course the landscape (river, mountains, volcano, etc.)

Use the tools to draw any parts you need which are not included in the graphics file. Take care with designing the whole scene well, using different sizes to show depth within your scene.

Fill each of the dinosaurs with a suitable flat colour (left fill box) and the scene only with a graded fill (bottom half of right fill box).

Save this as Dinosaur Scene

2. Use the tools in Painting to construct a picture of a multi-storey hotel and its grounds. Use copy and paste for the windows and any other repetitive shapes you require. It should have a sign on top, and probably at least a pool, tennis court, etc.

Experiment with filling your completed building and surrounds with patterns (middle fill box) and graded tones (top half of middle fill box) - no colours at all.

Save this as Hotel Westfields

To be completed for marking by - .................................
Animated Graphics
These are graphics which move - generally along some path on the screen. Most of us have drawn a little figure on the bottom corner of the pages of a pad, each with a small change from the previous one, and then flicked the pad so that the images appear to move. This is the simplest form of animation, and in fact, is much like the way the first moving pictures (movies) were produced.

Your next tasks are to produce several examples of animation.

Exercise 8

Slide Show
In order to understand the animation process, you are going to produce a figure on each page of an AppleWorks draw document and then run them through quickly (maximum 1 second) as a slide show (under the View menu) to produce a simple animation. Pages need to be set to 6 under Format - Document - Pages down.

For this to work effectively (and not be jerky) you need a simple stick figure which will look like it is running - this should only require around 6 different drawings (which you then repeat - using loop in Slide show).

You need to plan this figure on graph paper (to keep both the size and position consistent), numbering the 6 successive positions of legs and arms - the head and torso will remain constant.

This is then transferred to the first of the screens of the slide show, then copied and pasted to the second (and the changes made) and so on. Later you may wish to add a background to move through, a shadow, or other effects to indicate motion through a scene.